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Writer è il programma di videoscrittura del pacchetto Apache Open Office, che permette di 

creare documenti pronti per essere stampati, con una grafica nitida, e convertirli senza 

sforzo in PDF proprio come in altri formati integrati in molte piattaforme popolari. 

Writer ha delle potenti funzionalità che permettono di automatizzare compiti e aiutano a 

mantenere lo stesso stile in tutto il documento. Discuteremo degli stili nella prossima 

parte.  

Prima di discutere su come automatizzare compiti o decidere lo stile dei tuoi documenti 

abbiamo bisogno di imparare le diverse opzioni che permettono di inserire contenuti nel 

documento Writer. 

 

 

Quando apri la finestra di Writer, il documento sarà visibile come predefinito nella 

modalità "Layout di Stampa". Questa vista somiglia al documento finale. 

La differenza tra cos'è mostrato sullo schermo e ciò che viene stampato riguarda i bordi 

visualizzati e gli oggetti inseriti automaticamente sullo schermo, come discusso sotto. 
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 Bordi: Tutti i bordi, come ad esempio il bordo della casella di testo, il bordo 

della cella di una tabella, o il bordo degli oggetti OLE appariranno in grigio per 

aiutare l'utente durante la revisione. Quei bordi non sono né stampati, né esportati 

nel PDF. È possibile cambiare colore dei bordi (o eliminarli del tutto). Per cambiare 

l’aspetto dei bordi, vai su Modifica → Opzioni → OpenOffice → Apparenze e 

regolare le impostazioni sotto "bordi del Testo", i "Contorni degli  ggetti” e " ordi 

della Ta ella”.  

 

● Oggetti inseriti automaticamente: Oggetti, come tabelle di contenuti e i 

campi, hanno uno sfondo grigio. Ancora una volta, questo sfondo non viene 

stampato né esportato in formato PDF ed è visibile solo durante la scrittura. Per 

modificare quello sfondo, nello stesso menu ci sono opzioni separate per 

"Sfumature dei Campi" e "Indice e sfumature delle Tabelle". 

Come appena discusso nel capitolo dell'Interfaccia Apache OpenOffice, ci sono molti menu 

e barre degli strumenti che costituiscono le interfacce dei componenti di OpenOffice. In 

questo capitolo, ti mostreremo solo le caratteristiche essenziali di OpenOffice Writer. 
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La barra del titolo è collocata in cima alla finestra (sotto la barra del Menu nel Mac), e 

mostra il nome del file del documento attuale. Il nome di default per i nuovi documenti è 

“senza nome X”  dove X è un numero che dipende da quanti documenti sono aperto. 

 

 

La barra del menu è posizionata sotto la barra del titolo (nel Mac è posta sopra la Barra di 

Titolo). Le funzioni della barra del menu sono già state esaminate nella guida 

sull'interfaccia utente Apache OpenOffice. Ogni menu contiene un sotto menu con 

comandi più specifici. 

 

 

Writer ha due tipi di barre degli strumenti, una fissa e una mobile, come spiegato nella 

guida sull'interfaccia utente Apache OpenOffice. Le due barre degli strumenti più 
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importanti sono la barra degli strumenti standard e la barra di formattazione. Sotto la 

Barra del Menù vi è la barra degli strumenti standard, che fornisce funzioni di base come 

(ad esempio) aprire, salvare, stampare, tagliare, incollare, ed il tasto d'aiuto, in caso fosse 

necessario. La barra di formattazione è posizionata sotto la barra degli strumenti standard, 

e mostra gli strumenti in base a ciò che è stato selezionato. Ad esempio, quando il cursore 

si trova sul testo, gli strumenti sono per la formattazione del testo, invece quando il cursore 

si trova su un grafico, gli strumenti sono per la formattazione dei grafici, e così via. Per 

visualizzare o nascondere le barre degli strumenti, vai su Visualizza  Barre degli 

Strumenti  e fai click sul nome della  arra in questione.  ella guida all’Interfaccia Utente di 

Apache OpenOffice troverete più informazioni riguardanti lo spostamento e la modifica 

delle barre degli strumenti. 

 

 

La Barra Laterale è una nuova funzione di OpenOffice 4.0. Essa fornisce strumenti utilizzati 

frequentemente, raggruppati in gruppi. Per sapere di più sulla barra laterale, troverai tutto 

nella guida all’Interfaccia utente di Apache OpenOffice. 

 

 

Writer fornisce un righello/riga sugli assi orizzontali e verticali del documento. Il righello 

mostra la dimensione delle pagine, le posizioni delle tabelle, tratti, bordi e colonne. 

Per altre opzioni di visualizzazione del righello vai su Strumenti  Opzioni  OpenOffice 

 Visualizza. 
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Da qui, premi "Generale" per impostare l'unità di misura e lo spazio degli intervalli 

predefiniti. 

 

 

 

 

 

Puoi anche cambiare l'unità di misura del Righello cliccando con il tasto destro del mouse 

sul Righello, si aprirà un menu delle unità di misura. 

Per definire le impostazioni di indentazione e tabulazione, vai su Formato → Paragrafi → 

Tabulazione. Crea nuovi tipi di tabulazione scrivendo la posizione, selezionando il tipo di 

tabulazione e il carattere di riempimento. Poi clicca "Nuovo". 
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si prega di notare che definire tabulazioni usando gli stili dei paragrafi può 

essere più facile e veloce per ciò di cui hai bisogno. Vai su "Paragrafi" e "Stili 

dei Caratteri" per saperne di più. 

 

La barra di stato è posizionata in fondo alla finestra. Mostra informazioni riguardanti i 

documenti e fornisce la strada più semplice per modificare le impostazioni di un 

documento. 
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● Numero di pagina 

Consente di visualizzare il numero della pagina corrente, il numero di sequenza della 

pagina corrente (se diverso) e il numero totale delle pagine del documento. 

Se vengono creati segnalibri nel documento, un click destro su questo campo mostrerà 

l'elenco dei segnalibri. Fai click su quello desiderato per andare al punto di quel segnalibro. 

Puoi anche accedere al Navigatore cliccando due volte su questo campo. 

● Stile della pagina  

Mostra lo stile della pagina corrente. Per cambiarlo, click destro e scegli lo stile che 

preferisci dal menu. Oppure doppio-click per aprire la finestra di dialogo sugli stili di 

pagina. 

● Lingua 

Mostra il linguaggio del documento corrente. Clicca per aprire un menu per cambiare le 

impostazioni della lingua del testo selezionato. Scegliendo Nessuno (nessun controllo 

ortografico) si escluderà il testo dal controllo ortografico, e scegliendo Altro... si aprirà la 

finestra di dialogo dei caratteri. 

 

● Modalità inserisci 

Fai click per passare dalla modalità INST (Inserisci) alla OVER (Sovrascrivi). Nella modalità 

inserimento il testo verrà inserito dopo che la posizione attuale del cursore. Scrivere in 

modalità OVER comporta la sostituzione del testo successivo alla posizione del cursore. 

 

● Modalità seleziona 

Clicca per passare tra le modalità STD (Standard), EXT (Estesa), ADD (Aggiungi), e BLK 

(Blocca). Queste modalità di selezione sono spiegate nel Lavorando con il Testo. 
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● Modifiche non salvate 

Se le modifiche non sono state salvate, appare un asterisco (*). 

 

 

● Firma digitale 

Se un documento è stato digitalmente firmato  un’icona      vi appare. Doppio click su 

questo campo per vedere il certificato. 

 

Nota: Un documento può essere firmato digitalmente solo dopo averlo 

salvato. 

 

● Selezione e informazioni sugli oggetti 

Quando il cursore si trova in una sezione, intestazione, elenco, o su oggetto già 

selezionato, vengono visualizzate le informazioni pertinenti. Facendo doppio-click si apre 

la relativa finestra di dialogo. 

 

● Vista 

Clicca per cambiare il tipo di visualizzazione tra pagina singola, pagine affiancate e layout a 

libro. 
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● Zoom 

Trascina la barra dello zoom o clicca sui pulsanti + o -  per modificare l'ingrandimento. 

Oppure click destro sulla percentuale dell'ingrandimento per cambiare il valore. 

 

 

Abbiamo già introdotto la barra laterale nella sezione precedente sulla nuova interfaccia di 

Apache Open Office. La barra laterale di Writer è composta da quattro pannelli, che 

corrispondono alle icone del pannello sulla destra della barra laterale. Le sezioni sono 

descritte sotto: 

● Proprietà: Comprende strumenti per formattare direttamente il 

documento. Gli strumenti sono separati in tre sottomenù. 

o Testo: modifica il testo cambiando tipo, dimensione, colore, 

spessore, stile e spaziature dei caratteri; 

o Paragrafi: cambia lo stile del paragrafo cambiando allineamenti, liste 

o elenchi puntati, colore di sfondo, indentazioni, e spaziature; 

o Pagine: Formatta la pagina modificando orientamento, margine, 

dimensione ed numero delle colonne; 

 

Nota che in Writer, modificando le opzioni in questo pannello, cambierai lo stile 

della pagina in uso, modificando non solo la pagina corrente ma tutte le pagine che 

utilizzano lo stesso stile. Leggi di più sugli stili di Writer. 
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● Stili e formattazione: Gestire gli stili utilizzati nel documento, applicare gli 

stili esistenti, crearne di nuovi o modificarli. Questo pannello presenta inoltre una 

barra degli strumenti mobile a cui si può accedere tramite Formato → Styles e 

Formattazione. Approfondimenti riguardo alla barra degli Stili e della 

Formattazione su Stili in Apache OpenOffice Writer.  

● Galleria: Questo pannello ti permette di aggiungere immagini e diagrammi 

inclusi nella libreria di Apache OpenOffice. La Galleria è formata da due sezioni, la 

prima elenca le immagini per nome (Freccia, Sfondo, Diagramma, ecc.) e la 

seconda elenca le immagini appartenenti alla categoria selezionata. Con il 

pulsante Nuovo Tema puoi creare nuove categorie. Per inserire immagini, o 

aggiungere una nuova immagine alla galleria è sufficiente trascinare e rilasciare 

l'immagine selezionata. Questo pannello è collegato alla barra degli strumenti 

mobile a cui si può accedere da Strumento → Galleria. 

● Navigatore: Sfogliare il documento e riorganizzare il suo contenuto sono 

opzioni a cui si più accedere selezionando differenti categorie di contenuti, come le 

intestazioni, tabelle, cornici, grafici, ecc. Questa sezione fornisce inoltre una barra 

degli strumenti mobile a cui si più accedere da Visualizza → Navigatore. Leggi 

ulteriori informazioni su questo strumento. 

 

 

 

Quando OpenOffice è installato sul tuo computer, il suo menu principale viene integrato 

nel menu Programmi.  

Trovi Writer andando su Start → Programmi → OpenOffice → OpenOffice Writer. Su 

Mac i componenti sono accessi ili dall’icona di  pen  ffice nella cartella delle 
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Applicazioni. Doppio click sull’icona per accedere al menu iniziale. 

 

 

L'avvio rapido è un'icona che si trova nell'area di notifica o nella zona che indicata che 

Open Office è stato caricato ed è pronto per l'uso. Clicca sull'icona Avvio rapido di Open 

Office per aprire un menu a comparsa tramite il quale puoi aprire un nuovo documento, 

scegliendo un modello o scegliendo un documento esistente da aprire. Clicca sull'icona di 

Avvio rapido di Open Office per aprire la pagina iniziale.  

 

 

 

 

 

 

 

 

Se nessun documento è aperto in OpenOffice, puoi 

accedere alla pagina iniziale dal menu del sistema 

operativo o dall'icona  di Avvio rapido. Apri Writer 

scegliendo Documento di Testo o cliccando sulla 

sagoma dell'icona per scegliere il relativo tipo di 

documento. 
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Puoi usare un modello per creare un nuovo documento di Writer. Un modello è un insieme 

di stili e formattazioni predefiniti e può servire come base per documenti che seguono una 

certa disposizione.  ’installazione di OpenOffice non contiene molti modelli. Aggiungili 

scaricandoli dal seguente sito http://templates.openoffice.org/. 

 

 

Con OpenOffice aperto, premere Ctrl + N porta in primo piano la pagina iniziale. 

Con Writer aperto, premere Ctrl + N per aprire un nuovo documento di testo. 

 

 

 

Per aprire un documento dalla pagina iniziale fai click sul tasto Apri, si aprirà la finestra di 

dialogo "apri", da cui puoi selezionare il tuo documento. In alternativa, seleziona e tieni 

premuto il tasto Apri per scegliere da una lista di documenti recentemente utilizzati. 
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● Vai su File → Apri 

● Clicca sull’icona Apri                  nella barra degli strumenti. 

● Premi su   Ctrl + O. 

Apparirà la finestra di dialogo "apri". Scegli il file che desideri aprire e clicca Apri, il file si 

aprirà in una nuova finestra. Quando cerchi un file puoi filtrare e tramite i formati dei testi 

come .odt, .doc, .txt.  

 

 

 

 

 

Per salvare un nuovo documento segui uno dei seguenti punti: 

● Vai su File → Salva 

● Vai su File → Salva come 
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● Clicca sull’icona Salva   nella barra degli strumenti. 

● Clicca Ctrl + S  

Verrà mostrata la finestra di dialogo "salva", in cui puoi inserire il nome del file, verificarne il 

formato e la destinazione, infine clicca Salva. 

Per salvare un documento corrente con lo stesso nome, scegli File → Salva. 

 

 

Writer salverà il documento automaticamente allo scadere degli intervalli di tempo 

predefiniti. Salvando automaticamente si sovrascriverà l'ultimo stato del file salvato, come 

con il salvataggio manuale.  Per cambiare le impostazioni dell'auto salvataggio: 

1. Vai su Strumenti→ Opzioni → Carica/Salva → Generali 

2. Scegli l'intervallo di tempo in Salva automaticamente informazioni ogni ...  

3. Clicca OK quando hai finito. 
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Puoi salvare il tuo documento OpenOffice ODT in molti altri formati disponibili. Scambiare 

il tuo file OpenOffice ODT con gli utenti di Microsoft Word è un problema quotidiano. Il 

formato file ODT non è compatibile con Microsoft Word. 

Gli utenti di Microsoft Word possono installare un ODF add-in per MS Office per 

riconoscere il formato, ma gli utenti potrebbero anche non essere disposti o non essere in 

grado di farlo. Potrebbe essere più semplice salvare i tuoi documenti in un formato word.

   

● Per prima cosa, salva il file come ODT, altrimenti tutti i cambiamenti 

saranno salvati nella versione MS Word e la versione ODT andrà persa: 

o Vai su File → Salva come 

o Configura il formato Microsoft Word come preferisci, e clicca Salva. 

I cambiamenti fatti successivamente sul documento saranno salvati nel formato MS Word. 

Per tornare a ODT devi aprire di nuovo il documento. Per far sì che Writer salvi il 

documento di default nel formato del file Microsoft Word, vai su Strumenti → Opzioni → 

Carica/Salva → Generali. Nella sezione chiamata Formato di default dei file, cerca Tipo di 

documento e poi seleziona Documento di Testo. Sotto Salva sempre come, seleziona il 

tuo formato preferito.  

 

 

 

● Vai su File → Chiudi 

● Clicca sull’icona Chiudi [X] in alto a destra nella finestra in alto. 

Se il documento non è stato salvato dall'ultima modifica, una finestra di dialogo apparirà 

chiedendoti se vuoi salvare le modifiche. Scegli Salva per salvare le modifiche, Non salvare 

per chiudere il documento senza salvare le modifiche apportate oppure Annulla per non 

chiudere il documento.        
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L'utente ha tre modi per visualizzare un documento: layout di stampa, layout web e 

schermo intero. Per cambiare il tipo di visualizzazione, seleziona il menu Visualizza e scegli 

l'opzione di visualizzazione desiderata.  

 

Il layout di stampa è il tipo di visualizzazione predefinito. Usa il cursore dello zoom per 

aggiustare  

l'ingrandimento e utilizza le icone di layout nella  arra di stato per cam iare l’aspetto della 

pagina. Vai su Visualizza → Zoom per aggiustare le opzioni di aspetto e zoom nella 

finestra di dialogo Layout Aspetto e Zoom. 

 

Nella vista Layout web puoi usare il cursore dello zoom ma le icone di layout sono 

disabilitate. La finestra di dialogo Layout Vista e Zoom permette di utilizzare solo le 

opzioni di zoom. 
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Nella modalità schermo intero il documento è posizionato nella vista selezionata (layout di 

stampa o layout web) ma il documento riempie tutto lo schermo. Le barre degli strumenti 

e le barra laterale non vengono visualizzate. Premi Esc o l’icona  dello 

schermo intero per uscire da questa modalità. 

 

 

Writer ha implementato varie forme d’aiuto. Puoi scegliere aiuto tramite i file d’aiuto  Help 

files), i suggerimenti, e il menu cerca. 

 

 

Per accedere ai file d’aiuto premi F1 o vai su Help → OpenOffice Help o clicca sull’icona  

Aiuto presente nella barra degli strumenti. 

Verrà mostrata la finestra d’aiuto di  pen ffice. Puoi salvare le pagine d’aiuto 

aggiungendole ai preferiti: clicca sull’icona aggiungi ai preferiti . 

 

 

 

 

 

 

 

 



 
 
 

   
"Transmedia: a new narrative that involves communication and education towards the future classroom”. Code: 2014-1-ES01-KA201-004478 

This project has been funded with support from the European Commission. This publication reflects the views only of the author, and the 
Commission cannot be held responsible for any use which may be made of the information contained therein. 

This work is licensed under a Creative Commons Attribution-NonCommercial-NoDerivatives 4.0 International. Permissions beyond the scope of 
this license may be available at educationtransmedia@gmail.com 

 

24 

 

Per usare i suggerimenti vai su Aiuto → Cos’è questo? muovi il cursore su un’icona 

qualsiasi di Writer e verrà visualizzata una finestra con il suggerimento dove sarà descritta 

la funzione dell’icona. 

 

 

 

 

 

 

Per cercare una funzione o ottenere assistenza vai su Aiuto → Cerca e digita quello che stai 

cercando. Writer mostrer{ una voce che riporta alla funzione e i file d’aiuto relativi. 
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In Writer, mentre stai scrivendo, potresti aver bisogno di selezionare il testo. Selezionare 

una o più parole è relativamente semplice. 

Usando il cursore clicca sul testo e, tenendo premuto il tasto sinistro, sposta il mouse fino 

all’ultima parola da selezionare. Puoi anche usare le scorciatoie da tastiera. Una singola 

parola può essere selezionata con una doppia pressione sul pulsante sinistro del mouse, per 

selezionare l’itera frase tre pressioni e per selezionare l’intero paragrafo quattro. 

Con la tastiera: spostati con le frecce di navigazione per selezionare il testo desiderato 

tenendo premuto il tasto ⇧ Shift. 

 

 

Per selezionare velocemente l’intera pagina premi contemporaneamente Control + A, o vai 

su Edit → Select All. 

 

 

Seleziona tutto il testo con il cursore 

● Tieni premuto il tasto Control e usa il cursore per selezionare le altre parole. 

● Ripeti questi passaggi per tutte le parole che vuoi selezionare 
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Il testo potrebbe essere separato, da spazi o tab, in blocchi verticali. Per selezionare un 

testo formattato in questo modo devi cambiare la modalità di selezione del testo: Vai su 

Modifica → Modalità di selezione → Block Area or clicca con il tasto sinistro su STD nella 

barra di stato finché non verrà sostituito dalle lettere BLK.  

 

 ra puoi selezionare parole consecutive in verticale  come nell’esempio sotto riportato. 

 

 

 

Il testo può essere spostato in un documento, o attraverso i documenti esso si può fare 

tagliandolo o copiandolo e infine incollandolo. 

Per copiare o tagliare (il testo selezionato) puoi usare: 

● Scorciatoia da tastiera (shortcuts): Control + X (tagliare) o Control + C 

(copia); 

● Selezionandolo da menù: modifica > taglia o modifica > copia; 

● Menù del tasto destro: cliccare con il tasto destro sul testo sottolineato e 

scegliere taglia o copia; 

● Le icone: taglia           o copia. 
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Incollare il testo copiato o tagliato nel documento. Quando incolli il testo, la formattazione 

dipende da come era il testo e da come l'ha copiato. 

Per incollare e mantenere la formattazione del testo usa: 

● Scorciatoia da tastiera: Control + V; 

● Selezionandolo da menù: modifica → incolla; 

● Menù del tasto destro: cliccare sul tasto destro e scegliere incolla; 

● L'icona:  incolla. 

 

Per incollare testo senza mantenere la formattazione originale: 

 

● Scegli la freccia alla destra dell'icona per incollare e scegli incolla senza 

formattazione.  

● seleziona modifica → incolla speciale → testo non formattato 

 

Per altre opzioni per la formattazione del testo incollato, scegli dal menù a cascata 

dell'icona incolla o dalla finestra di dialogo dell'incollo speciale. 
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Ci sono diversi modi per creare un elenco puntato o numerato: 

● Auto formattato (parleremo dopo di questo) 

● Scegliendone lo stile (ne parleremo nel capitolo sullo stile) 

● L'icona per gli elenchi numerati e puntati nella barra degli strumenti. (L'uso 

di questa icona sarà descritto nella sezione sottostante) 

È importante ricordare che è meglio evitare l'uso degli elenchi numerati nei 

capitoli numerati.  n un’altra sezione di questa guida vedremo come numerare i 

capitoli e impaginare il documento. 

 

Per creare un elenco numerato o puntato, seleziona il paragrafo da trasformare in elenco e 

seleziona l'icona appropriata. 



 
 
 

   
"Transmedia: a new narrative that involves communication and education towards the future classroom”. Code: 2014-1-ES01-KA201-004478 

This project has been funded with support from the European Commission. This publication reflects the views only of the author, and the 
Commission cannot be held responsible for any use which may be made of the information contained therein. 

This work is licensed under a Creative Commons Attribution-NonCommercial-NoDerivatives 4.0 International. Permissions beyond the scope of 
this license may be available at educationtransmedia@gmail.com 

 

29 

 

Creando un elenco numerato o puntato, si attiverà il menù degli strumenti per gli elenchi.  

 

I bottoni numerati, nell'istantanea sopra, fanno le seguenti azioni: 

1. Elenco puntata ON\OFF 

2. Elenco numerata ON\OFF 

3. Elenco numerata OFF 

4. Avanzare di un livello 

5. Retrocedere di un livello 

6. Avanzare di un livello con i sottopunti 

7. Retrocedere di un livello con i sottopunti 

8. Inserire un elenco non numerato  

9. Spostare a una linea sopra 

10. Spostare a una linea sotto 

11. Spostare a una linea sopra con i sottopunti 

12.  Spostare a una linea sotto con i sottopunti 

13.  niziare nuovamente la numerazione dall’inizio 

14. Finestra di dialogo dell’elenco  puntato o numerato  

Le opzioni nella finestra di dialogo degli elenchi numerati e puntati sono le stesse con cui si 

edita lo stile, quindi queste proprietà saranno descritte nel capitolo sullo stile delle liste. 
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Come menzionato prima  gli elenchi di sottopunti si riferiscono al “livello” di un elenco 

puntato o numerato, vedi l'esempio sotto: 

1. Primo elemento 

1. Primo sotto elemento 

2. Secondo elemento 

1. Primo sotto elemento 

 

Per cambiare la posizione di una voce dell’elenco  usa Diminuisci / Aumenta livello  

nella barra degli strumenti degli elenchi puntati e numerati, oppure posiziona il cursore 

all’inizio della linea e premi Tab o Shift + Tab. 

 

Usa Auto Text per inserire testi, tabelle, comandi di campo ed altri oggetti da riutilizzare, 

assegnando una com inazione di tasti all’oggetto stesso  per il recupero. 

Per esempio, premendo dt e F3, un paragrafo lungo con un testo campione sarà inserito nel 

documento (nota: dt sta per dummy text (testo stupido) o acronimi differenti che possono 

essere applicati alle versioni non inglesi: usa Modifica → Auto text per vedere quello 

appropriato alla tua lingua). Premere fn e F3 produrrà una tabella con una riga e due 

colonne, con un oggetto matematico nella cella di sinistra e una variabile nell'altra. 

Entrambi gli esempi mostrano cosa Auto Text fa e il suo uso, che è quello di introdurre un 

frammento di documento precedentemente definito in un altro luogo usando solo 

un'abbreviazione e una scorciatoia da tastiera. 

 

 

 nserire un  uto Text digitando l’a  reviazione seguita da F3. 
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Per vedere le abbreviazioni disponibili, puoi scegliere Modifica → Auto Text (Ctrl + F3), ma 

un metodo più facile è attivare la barra degli strumenti Inserisci. Con la barra degli 

strumenti attiva scegli l'icona Auto Text              Ora puoi vedere le categorie Auto Text e le 

loro rispettive abbreviazioni. 

 

 

 

 

1. Selezionare il contenuto che vuoi utilizzare per un Auto Text. Il contenuto 

può essere qualsiasi cosa: testi, tabelle, disegni, cornici, sezioni, ecc. 

2. Con i contenuti selezionati, andare su Edit → Auto Text 

3. La finestra di dialogo Auto Text apparirà. Dai un nome la tua voce nella 

finestra rinomina. Writer suggerirà una scorciatoia da tastiera, che puoi cambiare. 

4. Nella finestra sulla sinistra, scegli una categoria per la voce, dove l'Auto Text 

sarà classificato. 

5. Seleziona il tasto Auto Text a destra e seleziona o Nuovo (solo testo) (perché 

l'Auto Text assuma la formattazione del testo circostante a dove è inserito) o Nuovo 

 perché l’ uto Text conservi la sua formattazione originale . 

6. Selezione Chiudi per ritornare al documento. 
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Se l'Auto Text contiene una tabella, è necessario selezionare almeno una linea 

prima e una linea dopo la ta ella  altrimenti soltanto il contenuto e non l’intera 

tabella andrà nell'Auto Text. 

 

Dentro la finestra di dialogo Auto Text, nota le seguenti caratteristiche: 

 con l'opzione Visualizza il resto del nome nella digitazione come 

suggerimento mentre scrivi attivata, Writer suggerirà un Auto Text se inizi a 

digitare il nome dell'Auto Text. Il suggerimento apparirà una finestra popup, 

e premendo invio sarà inserito l'Auto Text 

 Il tasto Categorie... consente di creare nuove categorie per classificare i tuoi 

Auto Text 

 Percorso... definisce dove salvare l'Auto Text 

 

 

Nella finestra di dialogo Auto Text (Modifica → Auto Text), puoi correggere il tuo Auto 

Text. Seleziona un Auto Text esistente, e scegli il tasto Auto Text per modificarlo o 

eliminarlo.  
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Selezionando Modifica, un documento si aprirà con l'Auto Text, non resterà quindi che fare 

le modifiche e salvare. Il nuovo Auto Text sarà disponibile come modificato.  

 

Il cambio sarà applicato ad Auto Text inseriti dopo la modifica, Auto Text già inseriti 

non saranno cambiati. 

 

 

 

1. Scegli Strumenti → Macro → Organizza Macro → OpenOffice Basics. 

2. Nella lista delle Macro, scegli OpenOffice Macro → Strumenti. 

3. Seleziona Auto Text e clicca vai. 

4. Una lista di nuovi Auto Text sarà creata in un nuovo documento. Puoi 

stampare questo documento. 

 

 

Puoi trovare parole in un documento con la barra di ricerca o con la finestra Trova e 

Sostituisci. 

Puoi inoltre: 

● trovare e sostituire parole o frasi 

● trovare e sostituire una formattazione specifica 

● trovare e sostituire lo stile di un paragrafo 

● usare espressioni regolari per trovare e sostituire il testo 

 

La barra di ricerca ti consente di cercare ed identificare specifici testi o frasi. 

Troverai la barra degli strumenti attraccata alla barra degli strumenti standard o scegliendo 

Visualizza → Barra degli strumenti → Trova. 
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Per visualizzare la finestra Trova e Sostituisci premi Control + F o scegliendo Modifica --> 

Trova & Sostituisci. 

 

1. Digita il testo che cerchi nella finestra trova; 

2. Per sostituire il testo, digita il nuovo testo nella finestra sostituisci; 

3. Per trovare il testo, premi Trova. Per sostituirlo, premi Sostituisci. 

Scegliendo Cerca tutto selezionerà tutte le istanze del testo cercato. Scegliendo 

Sostituisci tutto, sostituirà tutto. 

4. Puoi scegliere fra molte opzioni di ricerca come la differenza dei caratteri, 

scegliere intere parole o cercarne di simili. 

 

 

Per cambiare rapidamente il formato del testo da uno stile all'altro: 
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1. Scegli il comando Più opzioni per espandere la finestra di dialogo e 

vedere le opzioni di formattazione. 

2. Per cercare testi con formattazione specifica, riporta il testo nella 

finestra di ricerca. Per cercare solamente la formattazione, lascialo vuoto.  

3. Con la Ricerca per caselle seleziona, scegli Formato. 

4. Seleziona l'opzione di formattazione da includere e premi OK.  

5. Per sostituire con testi differenti e/o formattare, segui lo stesso 

procedimento della finestra di sostituzione. 

6. Scegli Trova, Trova tutto, Sostituisci, o Sostituisci tutto. 

 

Per cambiare rapidamente il formato del testo da uno stile all'altro: 

1. Scegli il comando Più Opzioni per espandere la finestra di dialogo 

2. Seleziona cerca per stile (se ci sono attributi specifici questa opzione è 

etichettata come includi stili) 

3. Seleziona gli stili da cerca per e sostituisci con nel menù 

4. Scegli cerca, cerca tutto, sostituisci, sostituisci tutto. 

 

Nota:   Puoi selezionare solo uno stile alla volta 

 

 

 

Le espressioni regolari (conosciute anche come wildcard) sono combinazioni di caratteri 

che servono a cercare qualcosa su Writers. 

1. Scegli il bottone più opzioni per espandere la finestra di dialogo 

2. Seleziona espressioni regolari  
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3.  igitare il testo da ricercare con l’espressione regolare con l’espressione 

regolare e l’eventuale testo sostitutivo 

4. Scegli Trova, Trova tutto, Sostituisci, o Sostituisci tutto. 

 

Esempi di espressioni regolari comuni: 

 

Per vedere una lista più completa di espressioni regolari, seleziona Aiuto →OpernOffice 

Help e cerca le espressioni regolari, scegliendo lista di per visualizzare la lista. 

I caratteri speciali sono caratteri che non si trovano sulla tastiera standard. Per esempio: 

∞øπƒ∆ sono caratteri speciali. 

1. Metti il cursore nel punto del documento in cui vuoi inserire il carattere 

speciale 
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2. Seleziona inserisci → Carattere speciale 

3.  ll’interno della finestra di dialogo  scegli il carattere e clicca ok 

 

Differenti font includono diversi caratteri caratteri speciali. Utilizza la selezione dei font 

per poter selezionare caratteri diversi. 

Uno spazio unificatore (NBSP) o trattini unificatori comunica a Writer che non deve può più 

andare a capo automaticamente. Gli spazi unificatori possono essere utilizzati alla fine 

delle frasi dopo le quali non inizia un nuovo paragrafo. Utilizzare un trattino unificatore per 

impedire che un trattino appaia alla fine di una line, ad esempio in un numero telefonico. 

 

 

Posiziona il cursore tra le due parole e premi Control + Spazio. 

 

 

Posiziona il corso dove vuoi che il trattino appaia e premi ⇧ Shift + Control + -. 

 

 

Per usare il trattino corto e il trattino lungo  l’opzione Sostituisci Trattini dovrà essere 

controllata da Strumenti → Opzioni di correzione automatica. Con questa opzione 

selezionata Writer sostituirà due trattini, in determinate condizioni, con il trattino 

corrispondente. 
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Nella tabella seguente la lettera A e la lettera B rappresentano un testo costituito da 

lettere dalla   alla Z o cifre da 0 a 9.  a ta ella descrive le differenti opzioni per l’uso del 

trattino corto e del trattino lungo. 

 

 

Il trattino corto e il trattino lungo possono anche essere inseriti manualmente 

attraverso Inserisci → Caratteri Speciale, usando i caratteri U+2013 or U-2014. 

Esistono anche delle scorciatoie per inserire il trattino corto o il trattino lungo che variano 

in base al sistema operativo. 
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La formattazione dei paragrafi in Writer può essere ottenuta attraverso allineamento, 

testo giustificato, spaziatura, elenco numerato o puntato è rientro. Queste azioni possono 

essere attuate usando i pulsanti nella  arra di  ormattazione.  ’immagine sottostante 

mostra la Barra di Formattazione con le icone specifiche per il paragrafo che appaiono. 

 

Nota: Si possono usare anche gli stili di paragrafo al posto di formattare 

manualmente i paragrafi, in particolar modo per i documenti lunghi. 

 

 

 

1. Apri la finestra Stili e Formattazione 

2. Applica Stile 
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3. Allinea a sinistra 

4. Centrato 

5. Allinea a destra 

6. Giustificato 

7. Spaziatura: 1 

8. Spaziatura: 1.5 

9. Spaziatura: 2 

10. Elenco numerato On/Off 

11. Elenco puntato On/Off 

12. Diminuisci Rientro 

13. Aumento Rientro 

14. Paragrafo 

 

 

 

 

 

Il testo può essere allineato a sinistra  al centro o destra del documento.  ’immagine 

sottostante mostra come appare il testo con le diverse opzioni di allineamento. 

 

 

 

Quando è in uso il testo giustificato  l’ultima linea è allineata a sinistra. Puoi anche allineare 

l’ultima linea al centro o giustificare l’ultima linea. Queste opzioni sono controllate nella 

casella Allineamento da Formato → Paragrafo. 
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Il righello mostra le tabulazioni predefinite. La tabulazione influisce sul rientro dei 

paragrafi. Si può cambiare manualmente il rientro dei paragrafi mediante le icone 

Aumenta Rientro o Diminuisci Rientro, o usando il tasto Tab ⇆. 

 e impostazioni di ta ulazione e rientro sono trattate nella sezione Righello dell’ nterfaccia 

Utente di Writer. 

 

 

 a formattazione dei caratteri in Writer può essere fatta grazie all’aggiustamento tramite 

font family, font weight, grandezza del font e colore. Queste azioni posso essere effettuate 

usando il bottone sulla barra degli strumenti per la formattazione.  ’immagine qui sotto 

mostra la barra degli strumenti per la formattazione con le specifiche e caratteristiche 

icone. 

 

Nota: Puoi usare lo stile dei caratteri piuttosto che formattare manualmente il 

carattere, specialmente per documenti molto lunghi. 
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1 Apri li stili e la formattazione della finestra   

2 Applica stile        

3 Nome del font       

4 Grandezza del font       

5 Grassetto        

6 Corsivo 

7 Testo sottolineato 

8 Superscript 

9 Subscript 

10 Aumenta grandezza font 

11 Riduci grandezza font 

12 Colore del font 

13 Testo evidenziato 

14 Colore dello sfondo 

15 Apri formato carattere 
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43 Writer formatta automaticamente parti del tuo documento, in base alle opzioni nella 

finestra di indicazione "Correzione Automatica" (Strumento: Opzioni → Correzione 

Automatica)

All'interno della finestra di Opzioni Correzione Automatica, il pulsante Aiuto si aprirà e 

descriver{ la scelta selezionata e come attivare l’auto formati. 

Per formattare automaticamente il documento con le opzioni selezionate, selezionare o 

deselezionare dal sottomenù in Formato → Correzione Automatica. 
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L'opzione predefinita, formatterà automaticamente il documento mentre digiti. 

 

 

Dopo aver scelto questa opzione, Writer formatterà automaticamente il documento. 

 

 

Dopo aver scelto questa opzione, Writer formatterà automaticamente il documento e 

aprirà una finestra dove potrai accettare o rifiutare le modifiche. 

 

 

Aprire la finestra Correzione Automatica. 

 

 

Le Note e le Note di chiusura commentano o citano referenze a una parte designata di 

testo. Le Note di chiusura si trovano in fondo alla pagina a cui si riferiscono, e le sono 

stampate alla fine del documento. 

 

 

Posizionare il cursore dove si vuole che vengano inserite le Note o le Note di chiusura. 

Selezionare Inserire -> Note/Note di chiusura o cliccare direttamente sull’icona apposita 

per Inserire Note o Note di chiusura            , o selezionare la Nota di chiusura direttamente                 

dalla barra degli strumenti di inserimento (Visualizza → Barre degli strumenti → 

inserimento). 
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Se usi Inserisci → Note/Note di chiusura, l'Inserisci Note/ Note di chiusura verrà 

visualizzata nella finestra. 

Da qui puoi scegliere il tipo di sequenza numerica e se inserire una Nota o una Nota di 

chiusura. 

 

Le Note o le Note di chiusura verranno inserite nel testo, e il cursore sarà collocato nello 

spazio Note o Note di chiusura alla fine della pagina o del documento. È possibile digitare il 

numero di Note o Note di chiusura in questo spazio. 

 

Per cancellare una Nota o una Nota di chiusura, basta semplicemente cancellare il 

marcatore corrispondente. Il contenuto di Note/Note di chiusura verrà automaticamente 

cancellato e il numero delle altre Note o Note di chiusura verrà aggiustato 

automaticamente. 

 

 

Per formattare Note o Note di chiusura, selezionare Strumenti → Note/Note di chiusura. 

Scegliere tra le impostazioni di numerazioni e stili e clicca OK. 
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Writer fornisce un correttore ortografico che offre due funzioni: 

● Il Controllo Automatico  controlla ogni parola digitata e evidenzia una 

linea rossa ondulata sotto ogni parola errata. Quando l'errore di ortografia viene 

corretto la linea rossa ondulata scompare. 

● Il correttore ortografico  esegue un separato controllo ortografico dei 

documenti quando clicchi l'icona. Il controllo automatico revisiona i documenti e 

apre la finestra di Ortografia e Grammatica se vengano trovate parole errate. Il 

controllo ortografico inizia dalla posizione attuale 

del cursore e si porta alla fine del documento. È 

possibile scegliere di continuare il controllo 

ortografico dall'inizio del documento. 

 

Altre caratteristiche del Controllo Automatico: 

● Fare clic destro su una parola con la 

sottolineatura ondulata per aprire un menu 

contestuale. È possibile scegliere tra le parole 

suggerite e selezionando una di esse si sostituirà la 

parola errata. 
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● All'interno della finestra Ortografia e Grammatica è possibile cambiare la 

lingua del dizionario, scegliendo dal menù nel campo Lingua Testo. Aggiungere una 

parola al dizionario selezionando una parola, fare clic su Aggiungi e scegliere il 

dizionario per aggiungerlo. 

 

 

 

● Per altre opzioni di controllo del testo, vai su Opzioni nella finestra 

“Controllo ortografico e grammaticale”. Puoi scegliere varie opzioni tra cui 

controllare le maiuscole o termini alfanumerici. 
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Writer non include un controllo grammaticale all’istallazione  ma è possi ile installare 

un’esenzione come  anguageTool che ha questo scopo. 

 

 

La lingua del documento determina il dizionario usato per il controllo ortografico.  Nel 

documento puoi applicare una lingua diversa per ogni paragrafo. Questa lingua ha priorità 

sulla lingua dell'intero documento. Puoi anche assegnare una lingua a parti selezionate del 

paragrafo, con una formattazione diretta.  

Writer fornisce alcuni strumenti che ti permettono di mescolare più lingue nello stesso 

documento, o facilmente cambiare la lingua all'interno del tuo documento. Questo può 

essere realizzato nel seguente modo: 

 Impostazioni lingua nelle opzioni. 

 Stile del paragrafo e del carattere. 

 Usare: "strumenti" → "menu lingua" 

 Usare la barra di Stato. 

 

 

Usare le impostazioni di lingua nelle Opzioni ti permette di impostare la lingua di tutto il 

documento. 

1. Seleziona Strumenti → Opzioni e vai su Impostazioni Lingua → Lingue. 

2. Sotto Lingue predefinite per documenti, seleziona la lingua del documento 

(questa verrà applicata a un documento appena creato). 

3. Se vuoi cambiare la lingua al solo documento attuale, seleziona " Solo per le 

opzioni del documento attuale". 
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Selezionare una lingua per lo stile di paragrafo: 

1. Posizionare il cursore nel paragrafo che vuoi editare, 

2. Tasto destro per aprire il contenuto del menu e seleziona Modifica stile 

paragrafo. 

3. Nella finestra di dialogo dello Stile del Paragrafo e seleziona Carattere. 

4. Seleziona la lingua da usare e clicca OK. 

 

 

Puoi impostare la lingua per il documento, paragrafo o carattere da Strumenti→ Lingua 

nella barra del menu. 

Per selezione: applica la lingua al testo 

selezionato. 

Per paragrafo: applica la lingua al paragrafo 

selezionato. 

Per tutto il testo: applica la lingua sull'intro 

documento. 

 

 



 
 
 

   
"Transmedia: a new narrative that involves communication and education towards the future classroom”. Code: 2014-1-ES01-KA201-004478 

This project has been funded with support from the European Commission. This publication reflects the views only of the author, and the 
Commission cannot be held responsible for any use which may be made of the information contained therein. 

This work is licensed under a Creative Commons Attribution-NonCommercial-NoDerivatives 4.0 International. Permissions beyond the scope of 
this license may be available at educationtransmedia@gmail.com 

 

50 

 

 

Cambiare la lingua del paragrafo e dell'intero documento dalla barra di stato: 

1. Clicca sulla lingua nella barra di stato per farla apparire nelle scelte nel 

menu. 

2. Scegliere "reset impostazioni di lingua" il paragrafo o l'intero documento 

alle impostazioni di lingua impostate in Strumenti→ Opzioni. 

 

 

 

Per accedere alla lista di sinonimi dal menu del contesto: 

1. Seleziona una parola, clicca con il tasto 

destro per aprire un menu contestuale 

2. Sotto Sinonimi ci dovrebbe essere un 

sottomenu con parole alternative 

3. Clicca sulla parola desiderata e 

quest’ultima sar{ messa al posto di quella 

selezionata in precedenza 

 

Per accedere ai contrari, che contiene una lista più estesa di sinonimi: 

1. Seleziona una parola o una frase 
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2. Scegli Strumenti→ Lingua→ Dizionario or Control+F7 o tasto destro e scegli 

Sinonimi → Dizionario. 

3. Scegli dalle parole nella finestra di dialogo per sostituire. 

 

 

 

In Writer puoi utilizzare la sillabazione automatica (Writer usa il dizionario della 

sillabazione) o manuale (inserire una tratto/meno quando è necessario). 

 

 

1. Apri la finestra di Stili e Formattazione (clicca sull'icona Stili e 

Formattazione oppure premi Control + T). 

2. Sotto la pagina degli stili del paragrafo, clicca su Default e seleziona 

Modifica. 

3. Nella finestra di dialogo degli stili del paragrafo, seleziona il tasto Flusso di 

Testo. 
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4. Sotto Sillabazione, seleziona o deseleziona l'opzione Automatico, poi 

clicca Ok per salvare. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Puoi scegliere l'opzione Sillabazione attraverso Strumenti → Opzioni → Linguaggio → 

Impostazioni → Aiuti di scrittura nelle Opzioni accanto al pulsante della finestra, scorri 

verso il basso per trovare le impostazioni della Sillabazione. 

Per cambiare il numero minimo di caratteri per la sillabazione, il numero di caratteri prima 

della linea di separazione, o del numero di caratteri dopo la linea di separazione, seleziona 

l'oggetto e clicca il pulsante Edita. 

 

La Sillabazione senza richiesta specifica che non ti sarà richiesta la sillabazione manuale 

che il dizionario della sillabazione non riconosce. Se questa finestra non è selezionata, 

quando una parola non è riconosciuta una finestra di dialogo si aprirà dove poi potrai 

inserire manualmente la sillabazione. 

 

Sillabazione a zone speciali specifica che la sillabazione verrà effettuata nelle note a piè di 

pagina, nell'intestazione e nel piè di pagina. 
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È consigliato non usare una sillabazione automatica, che rimane visibile tutto il tempo, 

anche se le parole non sono lunghe, alla fine di una linea quando aggiungi o elimini il testo 

oppure se cambi formattazione. 

 

Mentre è consigliato utilizzare un tratto/meno. Per inserire un tratto/meno dentro una 

parola, clicca dove vuoi che il tratto appaia e premi Control + Tratto. Il tratto apparirà 

solamente quando è alla fine della linea, anche se la sillabazione automatica è disattivata. 
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Il completamento della parola prova a indovinare la parola che stai digitando e si offre di 

completarla per te. Se il completamento della parola è inabilitata vedrai la parola completa 

evidenziata durante la digitazione. Per accettare il suggerimento premere "invio". 

Altrimenti continua a digitare e il suggerimento scomparirà. Per abilitare o disabilitare la 

completa zione delle parole, seleziona "strumenti" → "correttore automatico" → 

"completamento parola" →  "abilita completamento parola". 

Inoltre, puoi personalizzare il completamento della parola dello scrittore con le seguenti 

opzioni: 

● Applica spazio: aggiunge spazio automaticamente dopo una parola 

accettata. 

● Mostra suggerimento: mostra la parola suggerita come suggerimento 

(intorno alla parola) piuttosto che completare la parola durante la digitazione. 

● Raccolta parole: raccoglie le parole usate nel completamento della parola 

durante la scrittura di un documento salvandole per un utilizzo successivo in altri 

documenti. 

● Accogliere con: cambia la chiave che accetta il suggerimento. 

● Min. lunghezza di parola: cambia la lunghezza della più piccola parola da 

ricordare. 

● Max. inserimenti: cambia il numero massimo delle parole ricordate. 

● Eliminare la voce: elimina specifiche voci dalla lista del completamento 

delle parole. 
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La numerazione delle righe aggiunge il numero al margine del documento. 

 

 

Per abilitare la numerazione delle righe, selezionare strumenti → numerazione righe e 

selezionare "mostra numerazione" e cliccare "ok". 

Nella finestra di dialogo della numerazione delle righe puoi scegliere lo stile, formato e la 

pozione della numerazione, così come la spaziatura e numerazione degli intervalli di 

numerazione. 
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Per rilevare le modifiche fatte in un documento puoi: 

● fare modifiche su una copia del documento, e usare Writer per comparare le 

modifiche fatte fra l'originale e la copia 

● Attivare il rilevatore delle modifiche, che mostra dove hai aggiunto o 

eliminato del materiale o cambiato formattazione. Puoi rivedere e accettare o 

rifiutare ognuno di questi cambiamenti. 

 

 

1. Seleziona Modifica → Modifiche → Registrare. Per mostrare o nascondere 

lo schermo delle modifiche seleziona Modifica →  Modifiche →  Mostra. 

2. Per includere un commento insieme alla modifica, puntare il cursore 

nell'area della parola cambiata, e scegli Modifica → Modifiche →  Commenta. 

Quando scorri sulla modifica, Help Tips mostrerà il tipo di modifica, l'autore, la data 

e l'ora della modifica. Se vuoi un commento che si visualizzi anche sulla cima, 
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assicurarsi di avere Extended Tips abilitato (Strumenti →  Opzioni →  OpenOffice 

→  Generale and seleziona Extended tips). 

3. Per fermare la registrazione delle modifiche, seleziona Modifica → 

Modifiche → Registrazione per deselezionare la traccia). 

 

 

 

Per accettare o rifiutare la modifica registrata, puoi usare il tasto destro del mouse nel 

menù, o la finestra di accettazione o rifiuto delle modifiche. 

I risultati dell'accettazione e del rifiuto delle modifiche sono: 

- accettando un inserimento si rimuove il cambiamento di colore del testo 

inserito. 

- rifiutando un inserimento si rimuove il testo dal documento. 

- accettando una selezione si rimuove il testo dal documento. 

- rifiutando una selezione si rimuove il cambio di indicatore e si ristabilisce il 

testo nel documento. 
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Tasto destro del mouse sul menù 

1. Testo destro del mouse all'interno della modifica registrata 

2. Nel menu, scegliere Accetta modifica o Rifiuta modifiche. 

 

Finestra di accettazione o di rifiuto delle modifiche 

1. Seleziona Modifica →  Modifiche →  Accetta o Rifiuta. Questo aprirà la 

finestra di accettazione o di rifiuto delle modifiche. 

2. Le modifiche che non sono ancora state accettate o rifiutate vengono 

mostrate. Selezionando una modifica nella finestra si evidenzia la modifica stessa 

nel documento, quindi puoi vedere che cosa l'editore ha cambiato. 

3. Scegli Accetta o Rifiuta per accettare o rifiutare la modifica selezionata. 

Puoi scegliere Accetta tutto o Rifiuta tutto per accettare o rifiutare tutte le 

modifiche senza revisione. 

4. Per mostrare solo le modifiche fatte da determinate persone, o modifiche 

fatte sotto altre restrizioni, usa il Pannello dei filtri. Specifica il criterio dei filtri e 

ritorna al Pannello dei Filtri per vedere le modifiche. 
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Qualche volta più revisori ritornano alla versione modificata allo stesso tempo. In questo 

caso, puoi necessitare di rivedere tutte le modifiche del documento una ad una. 

Per questo scopo puoi unire i documenti in Writer. 

1. Apri una delle copie modificate 

2. Scegli Modifica →  Modifiche →  Unisci documento. Seleziona un'altra 

copia del documento da unire. 

3. La finestra di accettazione e di rifiuto delle modifiche si aprirà, mostrando le 

modifiche una ad una a ciascun revisore. Se vuoi unire più documenti, chiudi la 

finestra e ripeti lo step  

4. Tutte le modifiche registrate sono ora incluse nella copia aperta. Per 

memorizzarle, salva questo file sotto un altro nome. 

 

 

Qualche volta i revisori non possono tracciare le modifiche che fanno in un documento. In 

Writer puoi trovare le modifiche se confrontando i documenti. 

Devi avere il documento originale e quello modificato. 

1. Apri il documento modificato. Seleziona Modifica → Confronta 

documento. 

2. Seleziona il testo originale e scegli Inserisci. 

3. Le modifiche saranno evidenziate e la finestra di accettazione e di rifiuto 

delle modifiche sarà visualizzata nella sezione sovrastante. 
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Writer fornisce altri tipi di commenti, che vengono visualizzati al lato della pagina del 

documento, simili a dei "post-it". 

Questi commenti permettono agli autori di scambiarsi idee, chiedere suggerimenti oppure 

di fare un brainstorming durante il controllo. 

 

Per inserire un commento, posiziona il cursore nel posto in cui si vuole inserirlo e seleziona 

Inserire → Commenti, oppure premi Control + Alt + N. Il commento sarà ancorato al 

punto di riferimento tramite una linea tratteggiata, e raffigurato in una finestra sul lato 

destro della pagina dove puoi digitare il testo del commento. 

 

 a finestra del commento mostrer{ il nome degli autori e l’orario di quando è stato creato. 

Se più di una persona edita il documento, ogni autore è identificato con un diverso colore 

dello sfondo del commento. 

 

Cliccando sull'icona freccia nel menu del display del commento (un menu a tendina) dove 

puoi eliminare il commento corrente, tutti i commenti dal solito autore, oppure tutti i 

commenti nel documento. Cliccando a destra del commento ti darà ulteriori opzioni da 

applicare ai cambiamenti di formattazione del commento. 

 

Puoi passare da un commento ad un altro usando il Navigatore. Con il Navigatore aperto, 

espandi la sezione dei commenti e selezioni il testo del commento per spostarlo dal punto 

di riferimento di quest'ultimo. Puoi anche fare o eliminare i commenti dal Navigatore 

cliccando a destra del testo del commento e selezionare Commento → Edita o Elimina.     
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Seleziona il testo e scegli Strumenti →Conteggio parole. La finestra di dialogo del 

conteggio delle parole mostra il numero di parole e di caratteri selezionati, così come il 

numero di parole nel documento. 

 

 

 

Per cambiare il maiuscolo/minuscolo di una selezione, scegli "format" → "changing case" e 

scegli tra i seguenti: 

● Frase maiuscolo/minuscolo: solo la prima parola è maiuscola 

● minuscolo: non ci sono parole maiuscole (tranne i nomi propri) 

● MAIUSCOLO: tutte le lettere sono maiuscole 

● Ogni parola maiuscola: ogni parola è maiuscola 

● Invertire il maiuscolo/minuscolo: cambia ogni lettera nel suo 

maiuscolo/minuscolo opposto 
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